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Where to Find Information

This User's Guide

This guide leads you through the EPSON scanner software 
installation, tells you how to use the Start Button feature, and how 
to make basic software settings. It also offers troubleshooting tips 
and calibrating information.

GT-7000/GT-7000 PHOTO/GT-7000 USB User's Guide

This guide leads you through the scanner setup and options 
installation, tells you how to use the scanner, and how to make 
basic scans. It also offers troubleshooting tips and customer 
support information.

Information on EPSON Scanner Software for Windows

Online help provides you with detailed information on EPSON 
TWAIN and EPSON Scan! II. Access online help from the EPSON 
Scanner folder, or click the Help button in the EPSON TWAIN or 
EPSON Scan! II dialog box. 

Information on PageManager and other Software

See the PageManager for EPSON, and other software 
documentation. 
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Introduction

Features 

The CD-ROM that comes with your scanner contains the EPSON 
scanner software suite, which includes EPSON Scan! II and 
EPSON TWAIN, and is the perfect companion for your EPSON 
scanner. Using your scanner and software, you can scan images 
in color, grayscale, or black and white, and save them to disk as 
files. Other software such as EPSON Scanner Monitor and 
PageManager for EPSON provide full support of the Start Button 
feature to make scanning much easier.

❏ The software supports the following EPSON scanners: 
EPSON GT-7000/GT-7000 PHOTO/GT-7000 USB, and 
Perfection 636 and Perfection 636U.

❏ EPSON TWAIN directly controls all of the features of your 
EPSON scanner. This program is the core of EPSON Scan! II 
and the standard cross-platform interface for other 
application programs.

❏ EPSON Scan! II allows you to access all of the advanced 
features of EPSON TWAIN; to scan images, to save scanned 
images, and to export them into other applications.

❏ You can convert files into various formats, such as JPEG and 
TIFF, for use with your favorite desktop publishing or image-
editing software.

❏ EPSON Scanner Monitor allows your scanner to access 
software that supports the Start Button feature.
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❏ EPSON Screen Calibration utility allows you to calibrate your 
scanner and display monitor to reproduce images identical to 
the originals.

❏ PageManager for EPSON is TWAIN-compliant software that 
offers the Start Button feature. This feature allows you to scan 
and send data to a target application with a single push of the 
Start button. For more information on PageManager, see your 
PageManager documentation.

❏ The CD-ROM contains other useful application software that 
lets you use your scanner in various new ways. 
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About This Guide 

The information in this guide is divided into seven chapters, with 
a glossary and index also provided for your reference. 

❏ Chapter 1 contains information on installing the software. Be 
sure to read this chapter first.

❏ Chapter 2 explains the basics of scanning.

❏ Chapter 3 describes how to set up and use the scanner’s Start 
Button feature.

❏ Chapters 4 and 5 provide a complete description of EPSON 
Scan! II and EPSON TWAIN features. Refer to Chapter 4 
when making scanning settings.

❏ Chapter 6 explains how to calibrate your monitor with your 
EPSON scanner. If you notice that colors on your screen or in 
your printout do not match the original image, see this 
chapter.

❏ Chapter 7 contains troubleshooting information. If your 
software does not operate properly or scanned images are not 
what you expect, see this chapter.

Notes contain important information and useful tips on operating your 
scanner or software.

To set up and use the scanner itself, see your scanner's User's 
Guide. Online help can also provide you with information on making 
settings in EPSON TWAIN.
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System Requirements 

Before installing the scanner software, make sure that your 
system meets the following requirements.

For Windows with SCSI model users

Scanner: EPSON GT- 7000/GT- 7000 PHOTO, or 
Perfection 636

System: Microsoft® Windows® 95, Windows 98, 
Windows NT® 3.5x, or Windows NT 4.0

Interface: Adaptec® SCSI adapter

Display: VGA or higher resolution monitor 640 × 480 
screen resolution (800 × 600 or higher 
recommended), and 256-color (65,000-color or 
higher recommended)

Note:
Color and tone reproduction are subject to the 
display capability of your computer system, 
including the video card, display monitor, and 
software. See the product documentation for 
details.
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For Windows with USB model users

For Macintosh users

Scanner: EPSON GT- 7000 USB, or Perfection 636U

System: Microsoft® Windows® 98 preinstalled

Interface: USBSB1 adapter

Display: VGA or higher resolution monitor 640 × 480 
screen resolution (800 × 600 or higher 
recommended), and 256-color (65,000-color 
or higher recommended)

Color and tone reproduction are subject to 
the display capability of your computer 
system, including the video card, display 
monitor, and software. See the product 
documentation for details.

Scanner: EPSON GT- 7000/GT- 7000 PHOTO, or 
Perfection 636

System: Apple® Macintosh® computer with Power 
PC processor (except Power Book 100) 
running system 7.5.x, or later

Interface: Macintosh standard (SCSI)

 Note:
You cannot use a serial interface.
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EPSON Scan! II supports the Apple ColorSync™ 2.0 color 
management system and QuickTime™. These extensions are 
automatically installed during EPSON Scan! II installation.

Installing the Scanner Software for Windows 

After connecting the scanner to your computer, install the scanner 
software from the CD-ROM. The installation steps differ 
depending on the version of Windows. 

Find instructions for Windows 95 and NT 4.0 users in this section. 
Instructions for Windows 98 users can be found in “For Windows 
98 and SCSI users” on page 1-10 or "For Windows 98 and USB 
users" on page 1-15, depending on your scanner model. Windows 
NT 3.5x users see “For Windows NT 3.5x users” on page 1-22.

For Windows 95 and Windows NT 4.0 users

1. Make sure that the scanner is turned on.

2. Turn on the computer, and start Windows. 

If you are using Windows NT 4.0, insert the scanner software 
CD in the CD-ROM drive. Go to step 3.

Display: Color Monitor, 640 × 480 screen resolution 
(or higher recommended), and 256-color 
(32,000-color or higher recommended)

Note:
Color and tone reproduction are subject to the 
display capability of your computer system, 
including the video card, display monitor, and 
software. See the product documentation for 
details.
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If you are using Windows 95, one of the following dialog 
boxes will appear.

❏ If the dialog box below appears, insert the scanner software 
CD in the CD-ROM drive.

   

Select Driver from disk provided by hardware manufacturer, 
then click OK, and Browse. 

Select the CD-ROM drive, Epson folder, a folder for your 
language preference, and Win95 folder, then click OK. Go to 
step 3.
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❏ If the dialog box below appears, insert the scanner software 
CD in the CD-ROM drive, then click Next.

    

When you are asked for the drive and folder, select the CD-
ROM drive, Epson folder, your language preference, and 
Win95 folder. An example is shown below.
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When the following dialog box or similar appears, click 
Finish.

3. Double-click the My Computer icon.

4. Double-click the CD-ROM drive icon. A dialog box asking 
your preferred language appears on your monitor. If no 
dialog box appears, click the Cdsetup.exe icon.

5. Select your preferred language and click OK.

6. You will see the following dialog box. Click Add software.
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7. You will see the list of software in the list box. Click to select 
the names of the software you want to install in your PC. 
Make sure EPSON TWAIN and EPSON Scan! II are selected. 
Descriptions of the software can be found in the software 
documentation, or on the CD-ROMs that come with your 
scanner.

8. Click OK. Then follow the instructions on the screen.

The setup program installs EPSON TWAIN and EPSON 
Scan! II.

9. After  EPSON TWAIN is installed, the EPSON TWAIN Setup 
dialog box appears.

10. Make sure that SCSI is selected in the Interface pop-up list, 
and your EPSON scanner appears in the Port ID list. If not, 
see Chapter 7, “Troubleshooting.”

11. Place a document on the document table of the scanner.
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12. Click Test to check the connection. The scanner scans the 
document and if everything is properly installed and connected, 
a reproduction appears in the right window of the dialog box.

If no image appears, see Chapter 7, “Troubleshooting.”

13. Click OK to close the EPSON TWAIN Setup dialog box.

The EPSON Screen Calibration utility automatically starts. Go to 
page 1-22.

Note:
If the Film Adapter is installed, make sure it is switched off for the test 
scan to work properly. 
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For Windows 98 and SCSI users

Note:
If you are currently using Windows 95 and the scanner software is 
already installed, but you are upgrading from Windows 95 to 98, first 
uninstall EPSON TWAIN  while runnning Windows 95. Then reinstall  
EPSON TWAIN as described in step 1 below on Windows 98. When 
uninstalling EPSON TWAIN see page 1-19 .

1. Make sure that the scanner is turned on.

2. Turn on the computer, and start Windows.

3. When the dialog box below appears, insert the scanner 
software CD in the CD-ROM drive, then click Next.
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4. Select the Search for the best driver for your device option, 
then click Next.

5. Make sure the CD-ROM drive and Specify a location check 
boxes are both selected, then browse and select or type in the 
CD-ROM drive letter, Epson folder, the folder of your 
preferred language, and Win98 folder as the location, as 
shown below, and click Next.
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6. Follow the instructions on the screen. You may be asked to 
insert the Windows 98 CD-ROM.

7. The EPSON Screen Calibration utility automatically starts. 
Follow the instructions on the screen. For details, see page 1-
22. 

Note:
If the EPSON Screen Calibration utility doesn’t start automatically , 
see Chapter 6 to calibrate your screen after installing the scanner 
software. 

8. When the following dialog box is displayed, click Finish.

9. Double-click the My Computer icon.
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10. Double-click the CD-ROM drive icon. A dialog box asking for 
your preferred language appears on your screen. If no dialog 
box appears, click the Cdsetup.exe icon.

11. Select your preferred language and click OK.

12. You will see the following dialog box. Click Add software.

13. You will see the list of software in the list box. Click to select 
the names of the software you want to install in your PC. 
Descriptions of the software can be found in the software 
documentation, or on the CD-ROMs that come with your 
scanner. Make sure EPSON Scan! II is selected to be installed. 

14. Click OK. Then follow the instructions on the screen.

The setup program installs EPSON Scan! II.
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Note:
❏ If folders for the applications on the CD-ROM contain README 

files, double-click and read them as they contain up-to-date 
information regarding the software.

❏ You will find the  Scanners and Cameras icon shown below in 
the Control Panel after EPSON TWAIN is installed.
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For Windows 98 and USB users

1. Make sure that the scanner is turned on.

2. Turn on the computer, and start Windows.

3. When the dialog box below appears, insert the scanner 
software CD in the CD-ROM drive, then click Next.

    

4. Select the Search for the best driver for your device option, 
then click Next.
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5. Make sure the CD-ROM drive and Specify a location check 
boxes are both selected, then browse and select or type in the 
CD-ROM drive letter, Epson folder, the folder of your 
preferred language, and Win98 folder as the location, as 
shown below, and click Next.     

6. Follow the instructions on the screen. Depending on your 
system, you may be asked to insert the Windows 98 CD-ROM.

7. The EPSON Screen Calibration utility automatically starts. 
Follow the instructions on the screen. For details, see page 1-
25.

Note:
If the EPSON Screen Calibration utility doesn’t start automatically after 
installing the scanner software, see Chapter 6 to calibrate your screen.
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8. When the following dialog box is displayed, click Finish.

9. Double-click the My Computer icon.

10. Double-click the CD-ROM drive icon. A dialog box asking for 
your preferred language appears on your screen. If no dialog 
box appears, click the Cdsetup.exe icon.

11. Select your preferred language and click OK.

12. You will see the following dialog box. Click Add software.
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13. You will see the list of software in the list box. Click to select 
the names of the software you want to install in your PC. 
Make sure EPSON Scan! II is selected to be installed. 
Descriptions of the software can be found in the software 
documentation, or on the CD-ROMs that come with your 
scanner. 

14. Click OK. Then follow the instructions on the screen.

The setup program installs EPSON Scan! II.

Note:
❏ If folders for the applications on the CD-ROM contain README 

files, double-click and read them as they contain up-to-date 
information regarding the software.

❏ You will find the  Scanners and Cameras icon shown below in 
the Control Panel after EPSON TWAIN is installed.
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If you are upgrading from Windows 95 to Windows 98 

Before you upgrade from a Windows 95 operating system to 
Windows 98, you need to uninstall EPSON TWAIN. Follow the 
steps below.

1. Click the EPSON Scanner Monitor icon in the task bar and 
select Close to close EPSON Scanner Monitor.

2. Click the Start button, highlight Settings, and then select 
Control Panel.
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3. Double-click Add/Remove Programs. Select EPSON TWAIN  
and click the Add/Remove button. Then follow the 
instructions on the screen.

After you upgrade to Windows 98, install EPSON scanner 
software as described on page 1-10 for SCSI users or page 1-15 for 
USB users.
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For Windows NT 3.5x users

1. Make sure that the scanner is turned on.

2. Turn on the computer and start Windows.

3. Insert the scanner software CD in the CD-ROM drive.

4. Choose Run from the File menu.

5. Click Browse. Then select the CD-ROM drive.

6. Choose CDSETUP.EXE, then click OK. 

7. A dialog box asking for your preferred language appears on 
your monitor.

8. Select your preferred language and click OK.

9. You will see the following dialog box. Click Add software.
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10. You will see the list of software in the list box. Click to select 
the names of the software you want to install in your PC. 
Make sure EPSON TWAIN and EPSON Scan! II are selected. 
Descriptions of the software can be found in the software 
documentation, or on the CD-ROMs that come with your 
scanner.

11. Click OK. Then follow the instructions on the screen.

The setup program installs EPSON TWAIN and EPSON 
Scan! II.

12. When the following dialog box appears, follow the steps on 
page 1-8 from step 10.
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Installing the Scanner Software for Macintosh

After connecting the scanner to your Macintosh computer, install 
the EPSON scanner software; EPSON Scan! II, EPSON TWAIN, 
EPSON Scanner Monitor, PageManager for EPSON and other 
application software from the CD-ROM. Follow the steps below.

1. Make sure your scanner is on. Then turn on the computer.

2. Insert the CD in the CD-ROM drive. 

3. Double-click the CD-ROM icon to open it.

4. Double-click the EPSON Scan! II folder. 

Depending on country of purchase, the EPSON Scan! II folder 
may contain multiple-language versions of the software. 
Double-click the folder of your preferred language.

5. Double-click the EPSON TWAIN Installer icon.
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6. The installer software shows a dialog box. Click Install in the 
dialog box that appears, and follow the instructions on the 
screen.

When you have finished the entire installation, the EPSON 
Screen Calibration utility automatically starts. Go to page 1-
25 for instructions, then continue from step 7 below to install 
other software.

7. Double-click the folder that contains the software you want 
to install.

The Software folder may contain multiple-language versions 
of the software. Double-click the folder of your preferred 
language.

8. Double-click the installer icon to start the installation 
program. Then follow the instructions on the screen.
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For Macintosh and USB users

Note for iMac users:
❏ If you are using Mac OS 8.1, you need to install iMac Update before 

installing the scanner software. This is available online from the 
Apple Web site, where complete information on the software is 
provided.

❏ You do not need to install iMac Update with Mac OS 8.5.

1. Turn on the computer. 

2. Insert the CD in the CD-ROM drive. 

3. Double-click the EPSON TWAIN USB folder. 

Depending on the country of purchase, the EPSON TWAIN 
USB folder may contain multiple-language versions of the 
software. Double-click the folder of your preferred language.

4. Double-click the EPSON TWAIN Installer icon.

5. The installer software shows a dialog box. Click Install in the 
dialog box that appears, and follow the instructions on the 
screen.

When EPSON Scan! II, EPSON TWAIN and EPSON Scanner 
Monitor for USB installation is complete, the EPSON Screen 
Calibration utility automatically starts. See "Calibrating Your 
Screen" for instructions, then continue from step 6 below to 
install other application software.

6. Double-click the folder that contains the software you want 
to install.

The Software folder may contain multiple-language versions 
of the software. Double-click the folder of your preferred 
language.
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7. Double-click the installer icon to start the installation 
program. Then follow the instructions on the screen. 
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Calibrating Your Screen

You must calibrate your screen and scanner to reproduce images 
identical to the originals. 

Note:
The introductory Screen Calibration dialog box will not appear on 
Windows 98. Calibrate your screen by following the instructions from 
step 2 below.

During the EPSON scanner software installation on Windows, the 
following dialog box appears.



1-28      Installing the Software

PapU-S
Rev. B
A5 size Chap1.fm
3/1/99 Pass 0

L Proof Sign-off:
E.Omori _______
leadername _______
editorname _______

1. Click Next.

2. In the following window, move the slider to the right or left 
until the two shades of the gray horizontal stripes match.

Note:
View the screen from a distance. The gray stripes will not perfectly 
blend together; however, try to make the two tones match as closely 
as possible.

3. Click OK to register the calibration setting.

4. The message, “Setup is complete” appears. Click OK.

You will not need to change the screen calibration again so long 
as you continue to use the same display.

r
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Starting the Software 

After installing the scanner software, either the EPSON Scanner 
folder (or group) containing the EPSON Scan! II32 icon appears on 
your PC, or the EPSON Scanner folder containing the EPSON Scan! 
II  icon appears on your Macintosh HDD. If one of these does not 
appear, install the software as described on page 1-4 (Windows) or 
1-20 (Macintosh).

There are three ways to scan; with EPSON Scan! II, with an 
application that supports TWAIN, or with the ] Start button and 
preassigned application software.

If you .. 

� want to use EPSON Scan! II features to improve the scanned 
output, open EPSON Scan! II (see “Starting EPSON TWAIN 
through EPSON Scan! II” on page 2-3).

� do not have suitable scanning software or your software does 
not support EPSON TWAIN, open EPSON Scan! II (see 
“Starting EPSON TWAIN through EPSON Scan! II” on page 
2-3).

� use an application that supports EPSON TWAIN to scan, 
open your application (see “Starting EPSON TWAIN through 
your application software” on page 2-4).

� want to scan an image directly to your application  but do not 
want to have to open EPSON TWAIN or the TWAIN-
compliant application every time, setup the ] Start button and 
the application to work with (see Chapter 3 “Using the Start 
Button”). Then simply press the ] Start button.

Even if your application supports TWAIN, some features of 
EPSON TWAIN may not be available depending on the application 
software.
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Starting EPSON TWAIN through EPSON Scan! II

Before you start EPSON Scan! II, turn on the scanner and place a 
document on the document table. For instructions on how to 
place documents, see your scanner manual.

If you start your PC and EPSON Scan! II before turning on your 
scanner, you may not be able to scan properly.

1. For Windows 95, 98, and NT 4.0 users: 
Click Start, Program, EPSON Scanner, then choose EPSON Scan! 
II32, which is the 32-bit version of the scanning software. 

For Windows NT 3.5x, and Macintosh users: 
Open the EPSON Scanner group (folder). Then double-click 
the EPSON Scan! II32 icon (on Windows NT) or the EPSON 
Scan! II icon (on Macintosh).

on Windows NT 3.5x on Macintosh
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2. Choose Select Source from the File menu. Make sure that 
EPSON TWAIN 3 (32-bit) on Windows, or EPSON TWAIN 3 on 
Macintosh is selected in the Data Source list box, then click 
Select.

You usually need to perform this step only the first time you use the 
scanner with EPSON Scan! II.

3. Choose Acquire from the File menu to open EPSON TWAIN.

To scan the image placed on the document table of your scanner, 
go to “Scanning an Image” on page 2-5.

Starting EPSON TWAIN through your application 
software

Application programs that support the scanning interface 
standard TWAIN, allow you to scan images while an application 
is running. To verify whether your application is compatible with 
TWAIN, see your application documentation.
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How you should open EPSON TWAIN and scan varies 
depending on the application. Read the following to find out how 
to access EPSON TWAIN.

1. Start your application.

2. Select TWAIN Source from the File menu, and then select 
EPSON TWAIN 3 (32-bit) on Windows, or EPSON TWAIN 3 on 
Macintosh. If your Macintosh is connected through the USB 
interface, select EPSON TWAIN 3U in the Data Source list box.

You usually need to perform this step only the first time you use the 
scanner with your application.

3. Choose Twain Acquire from the File menu to open EPSON 
TWAIN.

To scan, see the next section.

Scanning an Image 

When you open EPSON TWAIN, the Easy menu appears. This 
section shows you the easiest way to scan by using the Easy menu. 
For detailed information about the settings on the Easy and 
Advanced menus, see Chapter 4.

Note for Macintosh users:
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Most illustrations shown in this chapter are for Windows, so they may 
vary from the actual dialog boxes that appear on your screen. You can 
use the dialog boxes following for both Macintosh and Windows 
reference however, as all the settings and functions are the same for both.

If the following menu appears, click Easy to see the Easy menu. The 
menu below is the Advanced menu of EPSON TWAIN. For details, see 
Chapter 4.

Follow these steps to scan an image:

1. Select the Document Source. 
You can select Flatbed, or ADF (for the optional Automatic 
Document Feeder), or TPU for Neg. Film or TPU for Pos. Film 
(for the optional Film Adapter) depending on whether you 
have installed options. For complete descriptions of 
Document Source settings, see “Document Source” in 
Chapter 4.

click
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2. Select the Image Type. 
You can select the type of image you will scan: 
Color Photo, 256 Colors, Black & White Photo, Line Art, OCR, or 
Copy&Fax. For complete descriptions of Image Type settings, 
see “Image Type” in Chapter 4.

3. Select the Destination.
You can select an output device for image reproduction from: 
Screen, Screen Vivid, Inkjet Printer, Laser Printer, Fax, OCR,  and 
certain EPSON printers.

4. Click Scan. 
The scanned image is displayed on the screen.

The scanner scans your image according to the Image Type and 
Destination settings you select. If you want more control over the 
settings, use the Advanced menu. See Chapter 4 or online help 
for complete descriptions of the settings. 

To exit from the EPSON TWAIN window, click the Close button 
in the Easy Menu.

Click
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Saving the Scanned Image 

� To save a scanned image in your application, choose Save or 
Save As from the File menu. For details, see your application 
documentation.

� To save a scanned image in EPSON Scan! II, follow the steps 
below.

Parenthesized words in the following steps apply to Macintosh users.

1. Choose Save As from the File menu. The following dialog box 
appears on the screen.

2. Select the directory (or folder) where the image will be saved.

3. Type a filename for your image in the File Name (Save Image 
as) field.

4. Click OK (Save).

The image is saved in EPSON's original file format. You can open 
this saved file in EPSON Scan! II and export it in a different 
format.
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EPSON Scan! II can only save and open images in EPSON's original 
file format; however, you can export the image to another application in 
a different file format, as described in the next section.

Exporting a Scanned Image From EPSON Scan! II 

After scanning an image in EPSON Scan! II, you need to export 
the image to use or edit it.

� The images saved in the EPSON Scan! II original file format cannot 
be opened or imported in other application software.

� For information on the file formats your software can open, see your 
software manual.

� EPSON Scan! II cannot open an exported image file. Always save 
an image in the EPSON original format before exporting.

Follow these steps to export the scanned image from EPSON 
Scan! II:

1. Choose Export from the File menu. The following dialog box 
appears on the screen.
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2. Select the directory (folder) where the image will be saved.

3. Type a filename for your image in the File Name (Export 
Image as) field.

4. Select the format in the File Format (Export File Format) 
menu. Click the arrow to see a list of available formats.

� Formats available 

Windows:
TIFF 5.0, EPS, DIB, PCX, TIFF 6.0 
(includes JPEG compression), and JPEG.

Macintosh:
PICT, TIFF 5.0, EPS, TIFF 6.0 
(includes JPEG compression), and JPEG.

� For more information on file formats and other features in this 
dialog box, see “Export” on pages 5-4.

5. Click OK (Export).

The image is saved in the selected file format. For information on 
importing the image into your application software, see your 
software documentation.
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Scanning by Pressing the Start button

You can open EPSON TWAIN, start scanning, and have the 
scanned image sent to a certain application, simply by pressing 
the 

 

]

 

 Start button on your scanner. To use this feature, you need 
to install PageManager for EPSON, or other Start button 
compatible software. The following occurs:

� Windows 98, or EPSON Scanner Monitor software on an 
operating system other than Windows 98, detects when the 

 

]

 

 Start button is pressed and sends information to the Start 
button compatible application, such as PageManager for 
EPSON.

� The Start button compatible application will automatically 
open EPSON TWAIN, scan the image and process it in the 
way the application is designed.

� You need to setup the Start button compatible software before using 
this feature. See Chapter 3 and the documentation that comes with 
the application.

� The scanned image will be handled by the software to its maximum 
capability. For example, using PageManager for EPSON, you can 
send the scanned image to a printer to print, or convert your scanned 
OCR image to text format and paste it in a wordprocessing 
application—all by simply pressing the 

 

] Start button.
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Getting Information From Online Help 

For Windows users:

If you are using EPSON Scan! II, choose Help from the menu bar. 
The status bar (at the bottom of the window) also gives you 
information on the features of EPSON Scan! II and EPSON 
TWAIN when you move the mouse over a button or menu item.

If you are using EPSON TWAIN, click Help on the advanced 
menu.

For Macintosh users:

If you are using EPSON Scan! II, choose Help from the Apple menu. 
Balloon Help also gives you information on the features of EPSON 
Scan! II and EPSON TWAIN.

If you are using EPSON TWAIN, click Help on the advanced 
menu.
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The Start Button Feature

The Start Button feature allows you to scan and send data to a 
target application with a single push of your scanner’s 

 

 ]  Start 
button. The following sections will help you set up your 
PageManager for EPSON and EPSON Scanner Monitor software, 
or Windows 98 system, so you can begin to use the Start Button 
feature.

Note for Windows 98 users:
The Start Button feature is supported by Windows 98, therefore you do 
not need to install EPSON Scanner Monitor software onto Windows 98.
See page 3-12 for the instruction of the Start Button feature. 

PageManager for EPSON

PageManager allows you to scan and send data directly to an 
assigned application with a single push of your scanner’s

 

 ]  Start 
button. You can also scan to any target application by simply 
clicking on the application icon in PageManager’s Scan Buttons 
bar. This section will help you set up PageManager so you can 
begin to scan using the  

 

] Start button. For more detailed 
information on PageManager settings, see your PageManager 
documentation.

For information on PageManager installation, see Chapter 1.

Target applications in the Scan Buttons bar

When PageManager is started, the Scan Buttons bar will appear 
on your screen. The icons in this bar represent target applications 
or periferal devices that can be accessed by your scanner. This 
means that you can scan and send data directly to these 
applications or devices by clicking on their icons.
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PageManager for EPSON also allows you to assign any one of the 
applications or devices on the Scan Buttons bar to the 

 

]  Start 
button. This means that an image can be scanned and sent straight 
to your selected application with one simple push of the 

 

]  Start 
button.

The application button showing the Start button icon represents the 
application that is assigned to the Start button.

Assigning an application to the Start button

To assign an application on the Scan Buttons bar to the  

 

 ] Start 
button, follow the steps below.

1. Select the Scan Buttons Setting from the File menu.

Start button icon
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2. Click the Start Button Settings tab in the Scan Buttons Setting 
dialog box. The following dialog box appears.

3. Select an application from the Select target application box 
and click OK.

Execute Scan Button automatically check box

When this check box is selected, the assigned application will 
automatically open and the scanned image is sent to the 
application when you press the  

 

] Start button. When this check 
box is clear, no application is assigned to the 

 

] Start button and 
only the Scan Buttons bar will appear when the  

 

] Start button is 
pressed. Then you can select an application from the Scan Buttons 
bar.
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Adding Applications to the Scan Buttons Bar 

You can add applications appearing in the Application bar at the 
bottom of the PageManager window to the Scan Buttons bar. 
Follow the steps below.

1. Select Scan Buttons Setting from the File menu. You will see 
the following dialog box.

2. Click the arrow next to the Scan to box and select an 
application you want to add to the Scan Buttons bar. Make 
the appropriate scanning settings for the application and click 
OK. 
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Suppress TWAIN User Interface check box

When this check box is selected, the EPSON TWAIN dialog box 
does not appear when you scan, and the scanner works according 
to the settings in PageManager. When this check box is clear, the 
EPSON TWAIN dialog box appears when you scan, and the 
scanner works according to the settings in EPSON TWAIN.

Enable Document Feeder check box

When this check box is selected, the scanner feeds your 
documents through the Automatic Document Feeder. When this 
check box is clear, the scanner scans your documents from the 
document table.

To remove applications from the Scan Buttons bar, select the icon of the 
application you want to remove in the box on the left of the dialog box, 
then click Remove.
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Setting up EPSON Scanner Monitor

EPSON Scanner Monitor is software that recognises when the 

 

]  
Start button is pressed and sends information to assigned  
application software supporting the Start Button feature and 
EPSON Scanner Monitor, such as PageManager for EPSON.

Once EPSON TWAIN is installed on an operating system other 
than Windows 98, EPSON Scanner Monitor is active and 
identifies PageManager for EPSON as the application that allows 
you to use the Start Button feature. If you need to turn off Scanner 
Monitor, or select another application that supports the Start 
Button feature, access Scanner Monitor as described below.

❏ Application software other than PageManager for EPSON which 
supports both EPSON Scanner Monitor and the Start button 
feature may be limited.

❏ Windows 98 supports the Start Button feature; therefore, EPSON 
Scanner Monitor is not installed automatically when you install 
EPSON TWAIN on Windows 98.

For Windows 95 or NT 4.0 users

Click the Scanner Monitor icon located in the task bar on your 
desktop.

Scanner Monitor icon
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❏ Turning off Scanner Monitor

If you want to turn off Scanner Monitor, select Close. 
However, this will disable the scanner’s Start Button feature.

After you turn off Scanner Monitor, it will turn back on 
automatically the next time you start Windows.

To activate Scanner Monitor, select Programs from the Start 
menu and click EPSON Scanner; then select EPSON Scanner 
Monitor. The Scanner Monitor icon appears in your taskbar.

❏ Assigning an application to Scanner Monitor

Select Preferences. The EPSON Scanner Monitor dialog box 
appears. You can select an application that supports the Start 
button feature and EPSON Scanner Monitor, such as 
PageManager for EPSON. 
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For Windows NT 3.5x users

Click the Scanner Monitor icon on the desktop.

❏ Turning off Scanner Monitor

If you want to turn off Scanner Monitor, select Close. 
However, this will disable the scanner’s Start Button feature.

After you turn off Scanner Monitor, it will turn on again 
automatically the next time you start Windows NT 3.51.

To activate Scanner Monitor, open EPSON Scanner group, 
and double-click the Scanner Monitor icon. The Scanner 
Monitor icon appears on your desktop.
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❏ Assigning an application to Scanner Monitor

Select Restore. The EPSON Scanner Monitor dialog box 
appears. You can select an application that supports the Start 
Button feature and EPSON Scanner Monitor, such as 
PageManager for EPSON.

For Macintosh users

Select Epson Scanner Monitor Setup from the Apple menu.

❏ Turning off Scanner Monitor
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If you want to turn off Scanner Monitor, clear the Enable 
Monitoring check box. However, this will disable the scanner’s 
Start Button feature.

To re-activate Scanner Monitor, select the Enable Monitoring 
check box.

❏ Assigning an application to Scanner Monitor

Click Browse. Select a folder and an application that supports 
the Start Button feature and EPSON Scanner Monitor, such as 
PageManager for EPSON.
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Setting Up the Start Button Feature for Windows 98

Without having EPSON Scanner Monitor installed, Windows 98 
allows you to use the  

 

] Start button on your scanner without 
having to open an application that supports the Start Button 
feature. When you press the  

 

] Start button, you can have a 
scanned image automatically sent to your application, such as 
PageManager for EPSON, as long as it is installed.

Once EPSON TWAIN is installed on Windows 98, the Scanners 
and Cameras icon appears on the control panel, and your scanner 
is listed in the Scanners and Cameras Properties dialog box as 
shown below.

Assigning an application to the Start button

After you install applications that support “Scanner events”, such 
as PageManager for EPSON, you need to select one of those 
applications for the scanner event.

If you want to use your scanner’s  

 

 ] Start button with 
PageManager for EPSON as the supporting application, follow 
the steps below.
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1. Select your scanner from the installed scanners and cameras 
list in the Scanners and Cameras Properties dialog box. Click 
Properties, and then click the Events tab.

2. You can see the Start Button is listed as the scanner event. 
Make sure the check box of the application you want to assign 
to the 

 

] Start button is selected and all other application check 
boxes are clear in the Send to this application list.

❏ If more than one application is selected, a dialog box appears 
prompting you to select an application when the Start button 
is pressed.

❏ Some applications do not support linkage to scanners and 
digital cameras. Linkage is available only with the applications 
that appear in the Send to this application list.

3. Close the dialog box by clicking the OK button.
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Disabling the Start button

If you need to disable the Start Button feature, select the Disable 
device event check box in the EPSON GT-7000 Properties dialog 
box. When this check box is clear, Windows 98 will detect if the 

 

] Start button is pressed and launch the application you selected 
in the Send to this application list.
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When you start EPSON TWAIN through EPSON Scan! II or a 
compatible application, one of the following windows appears on 
the screen:

Note for Macintosh users:
Most illustrations shown in this chapter are for Windows, so they may 
vary from the actual dialog boxes that appear on your screen. You can 
use the dialog boxes following for both Macintosh and Windows 
reference however, as all the settings and functions are the same for both.

The following sections describe all of the features of EPSON 
TWAIN.

Some settings may appear dimmed and cannot be selected because of 
incompatibility with your scanner or your choice of settings.

Easy menu Advanced menu
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Scanning From the Easy Menu 

The Easy menu displays the minimum required settings only, 
allowing you to scan easily and quickly. Just select the relevant 
Document Source, Image Type, and Destination settings, then 
click Scan. 

EPSON TWAIN automatically locates the target image on the 
scanner, adjusts the exposure, and starts scanning. See page 4-7 
through 4-14 for details about Document Source, Image Type, and 
Destination settings.

❏ You cannot scan an image that exceeds available memory or disk 
space. If you attempt to scan an image that is too large, an alert 
appears on the screen.

❏ Before you begin scanning, you should calibrate your screen. For 
details, see Chapter 6, “Calibrating Your System.“

❏ After an image is scanned, be sure to save or export it. See pages 2-
7 and 2-9 for details. 

If you want greater choice with your settings, or want to make 
more settings, click Advanced to open the Advanced menu.

Easy menu
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Scanning From the Advanced Menu 

The Advanced menu allows you to make detailed settings. You 
can set parameters for a setting or select special functions 
provided with EPSON TWAIN to attain the highest quality 
scanned images. 

❏ Online help also provides you with information on settings. See 
Chapter 2, “Getting Information From Online Help”.

❏ You cannot scan an image that exceeds available memory or disk 
space. If you attempt to scan an image that is too large, an alert 
appears on the screen.

❏ Before you begin scanning, you should calibrate your screen. For 
details, see Chapter 6, “Calibrating Your System.”

❏ After an image is scanned, be sure to save or export it. See pages 
2-7 and 2-9 for details.

Advanced menu
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Previewing images

Before you scan and save an image, you can preview it in the 
Preview window located on the right of the Advanced menu. Use 
the preview feature to check the results of your settings.

❏ To preview the entire image, click the preview button.

❏ To preview a part of the image that is already in the Preview 
window, click and drag the mouse over the area you want to see 
in detail, and click the zoom preview button.

❏ You cannot preview an image that exceeds available memory or disk 
space. If you attempt to preview an image that is too large, an alert 
appears on the screen.

❏ When the mouse pointer is placed within the marquee (the frame of 
the selected image area), the mouse pointer changes to a hand icon. 
You can click and drag the marquee anywhere in the Preview 
window.

zoom preview buttonpreview button
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❏ When the mouse pointer is placed on the edge of the marquee, it 
changes to an arrow allowing you to resize the marquee.

❏ To remove or delete a marquee, double-click the preview image.

Modifying the preview image

You can see the effects of the following settings in the preview 
image.

❏ Pixel Depth, Halftone, and Dropout in the Image Type dialog 
box

❏ Exposure, Gamma, Highlight, Shadow, and Threshold in the 
Image Controls dialog box

❏ Tone Correction in the Tone Correction dialog box

Preview
window
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❏ Gray Balance Intensity, and Saturation in the Color 
Adjustment dialog box

❏ Auto Exposure

Although the image in the Preview window changes as you make 
settings, the settings do not affect the actual image until you scan, or 
rescan, the image.

Document Source

When using the document table of the scanner, leave the 
Document Source set to Flatbed. Other selections which may also 
be available are ADF (for the optional Automatic Document Feeder), 
and TPU for Neg. Film or TPU for Pos. Film (for the Film Adapter 
optional for GT-7000 PHOTO), depending on whether you have 
installed these options.

Uninstalled options are not displayed. 

Flatbed:

Select this setting to use the document table of the scanner.

ADF:

Select this setting to use the optional Automatic Document 
Feeder.
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TPU for Neg. Film, TPU for Pos. Film:

Select one of these settings when using the Film Adapter. If 
you are scanning negative film, select TPU for Neg. Film, and 
if you are scanning positive film (or slides), select the TPU for 
Pos. Film setting.

Image Type

Use the Image Type list or button to select the type of image to be 
scanned.

 

Image Type list

The Image Type list provides the following predefined settings. 
EPSON recommends you use the predefined settings first, then 
later improve the quality of the scanned image manually by 
making the detailed settings described in the next pages, if 
necessary. Click the arrows on the right to view all of the available 
settings.

Color Photo:

24-bit Color, best quality, and 1-pass scanning sequence

256 Colors:

256 Colors and best quality

Image Type button Image Type list
(predefined settings)
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Black & White Photo:

8-bit Gray and best quality

Line Art:

Black and white, and draft quality

OCR:

Black and white, best quality, and Text Enhancement 
Technology

Copy/Fax:

Black and white, hard halftone, draft quality, and Auto Area 
Segmentation

Image Type button

The Image Type button allows you to customize the Image Type 
settings. If you want to make many detailed settings manually, 
use this feature.

Click the Image Type button, and the following dialog box appears.
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Image Type Name:

Names of predefined settings and custom settings you have 
saved appear in the Image Type Name list.

Pixel Depth:

Select scanning colors from: 
24-bit Color, 256 Colors, 8-bit Gray, and Black & White.

Halftone:

Select a halftone or dither setting to reproduce images using 
special dot patterns:
Mode A (Hard Tone), Mode B (Soft Tone), Mode C (Net Screen), 
Dither A (4 x 4 Bayer), Dither B (4 x 4 Spiral), Dither C (4 x 4 Net 
Screen), Dither D (8 x 4 Net Screen), or None.

Halftone is available only when Pixel Depth is set to Black & White.

Dropout:

Select a color to subtract from the scanned image. Available 
dropout options are: 
None, Red, Green, and Blue.

❏ Dropout is available only when Pixel Depth is set to 8-bit Gray 
or Black & White.

❏ Depending on the image you scan, you may need to adjust the 
Threshold setting in the Image Controls dialog box to enable 
this feature.
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Quality & de-screening:

Select a scanning quality:
Draft & fast or Best & de-screening.

When the Quality & de-screening option is selected, 
unwanted moiré patterns are automatically removed from 
scanned images.

B/W Options:

Select from :
Text Enhancement Technology,Auto Area Segmentation, or 
None.

Text Enhancement Technology
To raise the recognition accuracy during OCR (Optical Character 
Recognition) scanning, select this radio button. This function 
eliminates the document's background.

Auto Area Segmentation
To make grayscale images clearer and text recognition more 
accurate, select this radio button. This function separates text 
from graphics.

❏ The B/W Option setting is available only when Black & White  
is selected as the Pixel Depth setting.

❏ When you need neither TET nor AAS, select None . 

❏ Default is set to None.

  To apply the settings you made, click OK. The Preview 
window displays the effects of the current settings except for TET 
(Text Enhance Technology) and AAS (Auto Area Segmentation) 
settings.

To cancel the settings, click Cancel.
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To save the settings you made as a group of custom settings, type 
a new name in the Image Type Name box, then click Save.

To delete an Image Type setting, select the setting name to be 
deleted in the Image Type Name menu, then click Delete.

Destination 

Select the destination, or output device, where the scanned image 
is to be printed or displayed using the Destination list or button.

Destination list

The Destination list provides the following predefined settings 
and any custom settings you have saved in the Destination dialog 
box. Click the arrows on the right to view all the available settings.

Destination 
name

                    Resolution
Sharpness

Line drawings and 
halftone images 

Photos

Screen 72 dpi 72 dpi 0

Screen Vivid 72 dpi 72 dpi 1

InkJet Printer 720 dpi 360 dpi 1

Laser Printer 600 dpi 200 dpi 1

Fax 200 dpi 200 dpi 1

OCR 300 dpi 300 dpi 0

EPSON Printers 600 - 720 dpi 200 - 360 dpi 1

Destination button Destination list 
(predefined settings)
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The effects of the Destination settings cannot be viewed in the Preview 
window.

Destination button

The Destination button allows you to customize the Destination 
settings. To make your own settings, such as scanning resolution, 
click this button. The following dialog box appears.

Destination Name:

Names of the predefined and custom settings appear in 
the Destination menu.

Resolution:

Select a scanning resolution for line drawing and halftone 
images, or photos.
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❏ When the Pixel Depth setting in the Image Type dialog box is 
set to 8-bit Gray or Black & White, the Drawing/Halftone setting 
takes effect and the Photo setting becomes irrelevant. For other 
Pixel Depth settings, the Photo setting takes effect and the 
Drawing/Halftone setting becomes irrelevant.

❏ To print your scanned document when Resolution is set to 
Drawing/Halftone, select the same resolution setting from the list 
as you select in the printer driver. To print your scanned document 
when Resolution is set to Photo, select the resolution setting that 
is approximately 1/3 of the resolution you select in the printer 
driver; otherwise the Photo setting requires longer to print, but 
does not improve the output quality.

❏ The Resolution setting is closely related to the Image Size and 
Scale settings. If you change them arbitrarily, the resulting 
image may not be what you expected.

❏ The availability of the resolution value depends on your 
scanner.

Sharpness:

You can select from -2 (soft focus) to 2 (sharp focus) in the list.

To apply the settings you made, click OK. To cancel the settings, 
click Cancel.

To save the settings you made, type a new name in the Destination 
Name box, and then click Save.

To delete a Destination setting, select the target setting name to 
be deleted in the Destination Name menu, then click Delete.
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Source and Target image sizes

The Source fields indicate the size of the image that is displayed 
or selected in the Preview window. 

The Target fields indicate what size the image will be when it is 
output.

❏ The image size values are determined automatically when you 
scan from the Easy menu.

❏ The image size setting is closely related to the Resolution. If you 
change them arbitrarily, the resulting image may not be what 
you expected.

Width and Height menu:

The width and height of an image are indicated in the selected 
unit of measure. You can type new values directly in the 
indicator fields, or you can change the image area in the 
Preview window by creating a marquee, or frame. Do this by 
dragging the mouse over a certain area. See the notes on page 
4-5 for more information on marquees.
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Units menu:

Select a unit of measurement. You can select from pixels,  
inches, and cm. 

Storage size indicator:

The storage size of an image is indicated in KB or MB. As you 
change the image area in the Preview window, this value also 
changes.

Lock button:

The current ratio of width-to-height of the target image can 
be locked, allowing the ratio of width-to-height of the Source 
image to change according to the scale value, or the scale 
value to change according to the ratio of width-to-height of 
the Source image. This is especially useful in cases where the 
size of an image does not fit the paper size you want to print 
the image on, but you want to keep the image's original 
proportions. Enter the size of the paper in the Width and 
Height fields of the Target box and then click the lock button. 
The scale value is automatically changed, maintaining the 
current ratio of width-to-height to fit the paper.

Scale bar:

An image can be reduced or enlarged by moving the Scale 
slider. You can also click the left or right arrow to change the 
image size in 1% increments.

The range of possible reduction or enlargement varies 
depending on the current resolution setting.

Scale indicator:

The percentage of enlargement or reduction is shown in the 
Scale indicator field. You can type a new value directly into 
this field, or use the Scale slide to determine the value.



4

Understanding EPSON TWAIN Features      4-17

PapU-S
Rev. B
A5 size Chap4.fm
3/1/99 Pass 0

RProof Sign-off:
E.Omori _______
<leadername> _______
<editorname> _______

Image Controls

Click the Image Controls button on the Advanced menu to view 
the following dialog box.

❏ The Image Controls button appears dimmed and is not available 
when TET (Text Enhancement Technology) is selected in the Image 
Type dialog box.

❏ The Image Controls settings are optimized automatically when you 
scan from the Easy menu.

❏ If Pixel Depth is set to Black & White and Halftone is set to None 
in the Image Type dialog box, all the settings except Threshold 
appear dimmed and cannot be selected.

❏ You can see the effects of the Image Controls settings in the Preview 
window.
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Exposure:

The Exposure setting lightens or darkens an image. You can 
select from -10 (darkest) to 20 (brightest) by moving (clicking 
and dragging) the slider.

The Exposure and Highlight controls are related. When the 
Exposure setting is changed, the Highlight value is 
automatically set.  

Gamma:

Gamma is the contrast between the light tones and the dark 
tones in an image. You can select from 50 (lowest) to 500 
(highest) by moving the slider.

Highlight:

The Highlight control allows you to adjust the brightness 
level of the brightest parts of an image. You can select from 
61 to 490 by moving the slider.

Click the eyedropper button beneath the slider, and the 
mouse pointer changes to an eyedropper icon. Then move the 
eyedropper over the preview image, and click a bright area. 
The eyedropper “picks up” the color from that area, and uses 
it as the highlight for the entire image. This effect shows up 
immediately in the preview image. Click Cancel to restore the 
original image.

Shadow:

The Shadow control allows you to adjust the darkness level 
of the darkest parts of an image. You can select from 0 to 60  
by moving the slider.



4

Understanding EPSON TWAIN Features      4-19

PapU-S
Rev. B
A5 size Chap4.fm
3/1/99 Pass 0

RProof Sign-off:
E.Omori _______
<leadername> _______
<editorname> _______

Click the eyedropper button beneath the slider, and the 
mouse pointer changes to an eyedropper icon. Then move the 
eyedropper over the preview image, and click a dark area. 
The eyedropper “picks up” the color from that area, and uses 
it as the shadow for the entire image. This effect shows up 
immediately in the preview image. Click Cancel to restore the 
original image.

Threshold:

Available only when Pixel Depth is set to Black & White and 
Halftone is set to None in the Image Type dialog box. The 
scanner scans gray shades as either black or white using this  
setting.

You can select from 0 (lightest) to 255 (darkest) by moving the 
slider.

Tone Correction
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Click the Tone Correction button on the Advanced menu to view 
the following dialog box.

tone curve 
editor

tone correction lis
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❏ The Tone Correction settings are determined automatically when 
you scan from the Easy menu.

❏ The Tone Correction button appears dimmed and is not available 
when Pixel Depth is set to Black & White, Halftone is set to None, 
and TET (Text Enhancement Technology) is selected in the Image Type 
dialog box. 

❏ You can see the effects of the Tone Correction settings in the Preview 
window.

The tone value represents the contrast in the tonal relationship 
between an original image and its reproduction on the display 
monitor or printer.

Tone Curve editor:

The editor allows you to customize tone correction. Drag 
points on the tone curve to adjust the tone value. You can edit 
up to five tonal elements.

Output options:

If you select the check box for a specific point, such as 1/4 
Tone or Midtone, you can move that point and it will remain 
in place; it will not be affected by the movement of other 
points on the curve. If the check box is clear, the point will be 
affected by the movement of other points.

Channels options:

You can select the combined red, green, and blue (RGB) 
channel to modify all colors, or select these colors separately.

If Pixel Depth is set to Black & White or 8-bit Gray in the Image 
Type dialog box, you can only select the combined RGB channel 
option.
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Tone correction list:

Select a tone correction setting from this list. The custom 
settings you have saved appear in this list.

OK/Save/Delete/Cancel buttons:

To accept the defining Tone Correction or close the dialog box,
click OK.

After you correct tone, type a name for your custom settings in 
the tone correction list and click Save.

To delete a setting, select the name of the setting you want to 
delete in the tone correction list and click Delete. 

To cancel the operation, click Cancel.

Color Adjustment

Click the Color Adjustment button on the Advanced menu to view 
the following dialog box.
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❏ The Color Adjustment settings are determined automatically when 
you scan from the Easy menu.

❏ If Image Type has been set for other than 24-bit Color or 256 
Colors, or Pixel Depth is set to 8-bit Gray or Black & White, the 
Color Adjustment button appears dimmed and these settings cannot 
be selected.

❏ You can see the effects of the Color Adjustment settings in the 
Preview window.

Gray Balance Intensity:

Adjust the gray balance of a color combination that appears 
neutral gray by removing color casts from the selected color.

Click the eyedropper button beneath the slider, and the 
mouse pointer changes to an eyedropper icon. Then click the 
color you want to modify. The eyedropper “picks up” the 
color and displays it in the box beside the eyedropper button. 
You can then correct the cast level for that color from 0 to 100 
by moving the slider. The corrected color appears in the box 
on the right, and the effect shows up immediately in the 
preview image. Click Cancel to restore the original image.

Saturation:

Saturation is the property that defines color as pale or rich. 
Select the saturation level for color from -100 (less color) to 
100 (more color) by moving the slider. 

The scanner scans the strength of color using this saturation 
setting. 
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Auto Exposure

Click the Auto Exposure button on the Advanced menu to 
automatically optimize the exposure for an image. The Highlight 
and Shadow settings in the Image Controls dialog box are 
automatically set.

❏ The Auto Exposure button appears dimmed and is not available 
when TET (Text Enhancement Technology) is selected in the Image 
Type dialog box.

❏ The Auto Exposure feature is automatically activated when 
scanning from the Easy menu.

Reset Button

Use the Reset Button to change the image control settings you 
made back to their default settings. If you do not alter any image 
control settings, this button appears dimmed and is not available.  
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Auto Locate

Click the Auto Locate button on the Advanced menu to cause the 
scanner to automatically locate and select the target image. The 
image appears without white borders in the Preview window.

❏ The Auto Locate button appears dimmed and is not available when 
TET (Text Enhancement Technology) is selected in the Image Type 
dialog box.

❏ The Auto Locate feature is automatically activated when scanning 
from the Easy menu.

located image

Auto Locate button

entire preview area
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If a document contains more than one image, select a target image 
by dragging the mouse pointer over the image and clicking the 
Auto Locate button. The selected target image is located 
automatically.

Auto Locate button

located and 
non-located images

target image and other 
image
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Settings

Click the Settings button on the Advanced menu to view the 
following dialog box. You can view all the settings for the current 
preview image in this dialog box. Also, you can apply any custom 
settings you have saved.

To save the currently selected settings, type a new name in the 
User defined settings field, then click Save.

To apply saved settings, select a setting name from the list, then 
click OK. The preview image will reflect the settings you saved.

To restore the prior settings, click Cancel.

To delete a setting, select the setting name in the list, then click 
Delete.

To scan a single image using several variations of settings, make 
and save each group of settings as described above. Then hold 
down the Shift key while clicking the custom settings you want to 
select in the User defined settings list. After selecting all the settings 
you want to use when scanning, click Batch Scan. The scanner scans 
the image once for each group of settings you have selected.
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Configuration 

Click the Configuration button on the Advanced menu to view the 
following dialog box. You can make settings that affect the Preview 
window.

Save Preview Image and Settings:

Select this check box to automatically save the preview image 
and all the image settings when you exit EPSON TWAIN (quit 
scanning). The next time you restart EPSON TWAIN, the last 
preview image and settings will reappear.

Windows

Macintosh
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Fast Preview:

Enables high-speed loading of the preview image.  If this is 
selected, the preview image is scanned in Draft & fast mode. 
If this is not selected, the preview image is scanned in Best & 
de-screening mode, and you can get accurate values of the 
Highlight, Shadow, and Gray Balance Intensity by sampling 
using the eyedropper in the preview image.

Do not use this feature (do not select the check box) when 
quality is more important than speed. 

Automatic Preview:

Previewing automatically starts when you acquire an image 
with EPSON TWAIN (if this check box is selected).

Auto Exposure on Preview:

Displays the preview image having automatically optimized 
exposure settings. The result is the same as if you clicked the 
Auto Exposure button.

ICM, ICM/sRGB (for Windows)

Depending on the Windows version, this setting may not be 
available or the caption is different.

Select this check box to reproduce the colors in your image 
using the Windows ICM color management system. This 
setting appears only in Windows.

❏ If your output devices (printer and monitor) do not support 
ICM, leave this check box clear.

❏ See page 6-4 for more details.
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ColorSync (for Macintosh)

Select this check box to reproduce the colors in your image using  
the ColorSync color management system. This setting appears 
only with Macintosh.

If your output devices (printer and monitor) do not support ColorSync, 
leave this check box clear.
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EPSON Scan! II is software that allows you to access EPSON 
TWAIN to scan images. You can then save the scanned images 
and export them into other formats.

The following sections describe how to use the advanced features 
of EPSON Scan! II.

Parenthesized words following apply to Macintosh users.

File Menu 

This section describes the commands located on the File menu 
and the functions those commands perform. To access these 
commands, open EPSON Scan! II and click File.

For detailed information about the settings in the EPSON TWAIN 
window, see Chapter 4.

Select Source

Before using the scanner, choose Select Source and select EPSON 
TWAIN 3(32-bit)  on Windows, or  EPSON TWAIN 3 on Macintosh 
from the Data Source name box. This procedure only needs to be 
performed the first time you start scanning. 
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Acquire

To scan an image, choose Acquire. EPSON TWAIN opens and one 
of the following menus appears.

Click Scan, and a scanned image of the document on the 
document table will appear on your screen. Be aware that it may 
appear behind the menu.

Save As

To save the scanned image in the EPSON Scan! II original file 
format, choose Save As. Type a name for the file in the File Name 
(Save image as) field, and then click OK (Save).

To save the scanned image in a file format that other applications 
can open, see the section below.
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Export

The files saved in the EPSON Scan! II original format (*.org) 
cannot be opened by other application software. To use the 
scanned image in other application software, you must save it in 
an appropriate file format by exporting it. Follow the steps below.

Note:
EPSON Scan! II can only open files saved in the EPSON original file format. 
Therefore, it is recommended that you first save your image in the EPSON 
format in case there is a problem opening the image in your application.

1. Choose Export. The following dialog box appears.

2. Select the directory (folder) where the file is to be saved. 

3. Type a name for the file in the File Name (Export image as) 
field.

4. Select the desired file format from the File Format (Export File 
Format menu and then click OK (Export).
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The following file formats are available:

TIFF 5.0: Standard Tagged Image File Format version 
5.0. Black-and-white images can be 
exported with G3 compression.

EPS: Encapsulated PostScript file format.

TIFF 6.0
(JPEG):

Tagged Image File Format version 6.0 with 
JPEG compression.

TIFF 6.0 (JPEG) can only be selected for 16-
million color or 256-gray level images.

JPEG: Joint Photographic Experts Group format 
for data compression.

JPEG can only be selected for 16-million color or 
256-gray level images.

DIB:
(Only for 
Windows)

Device-Independent Bitmap format for 
Windows version 3.0 or later. 4-bit/pixel 
images can be exported with RLE4 
compression and 8-bit/pixel images can be 
exported with RLE8 compression. RLE 
stands for run-length encoding.

PCX:
(Only for 
Windows)

PC Paintbrush file format.

PCX cannot be selected for 16-million color 
images.

PICT:
(Only for 
Macintosh)

Standard QuickDraw™ picture format for 
Macintosh. Black & white images can be 
exported with G3 compression and 16-
million color or 256-gray level images can 
be exported with JPEG compression.
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Your software probably supports many of these formats. For 
information on supported formats, see your software manual.

The DIB (256 color, 256 gray, 8 color, 16 gray) and TIFF 5.0 (Black 
& White) formats allow you to compress the file to be exported. 
To compress the file, click the Compression check box.

If you select JPEG, TIFF 6.0 (JPEG), or PICT (JPEG compression), 
you can adjust the image quality level from 1 (poorest) to 5 
(highest) by moving the Quality slide at the bottom of the dialog 
box.

Acquire & Export

To scan and save the image directly in a file format that your 
application can open, choose Acquire & Export. Because the 
scanned image does not appear on the screen, you can carry out 
scanning operations more quickly using this method.

1. Choose Acquire & Export. EPSON TWAIN opens. 

2. Click Scan to open the Export dialog box.

If you have selected ADF as the Document Source in EPSON 
TWAIN, a dialog box appears that prompts you to select the number 
of pages to be scanned. Click OK with All Pages selected to scan all 
pages loaded in the ADF. Select Single Page for scanning one page 
at a time.

3. Select the directory (destination folder) where you want to 
save the file.
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4. Type a file name and set other options if desired. Click OK to 
start scanning and save the image in the selected file format.

If you have selected ADF as the Document Source in EPSON 
TWAIN, and type a file name with more than 6 letters in the file 
name box, the last 2 letters may be changed into a number that 
indicates the page order of scanning.

Close

Choose Close to close an image window.

Open

To open files that have been saved in the EPSON Scan! II original 
format (*.org), choose Open.

EPSON Scan! II can only open files saved in the EPSON original file 
format. Therefore, it is recommended that you first save your image in 
the EPSON format in case there is a problem opening the image in your 
application.

Exit

Choose EXIT (Quit) to close EPSON Scan! II.
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Edit Menu 

This section describes the commands located on the Edit menu 
and the functions those commands perform. To access these 
commands, open EPSON Scan! II and click Edit.

Copy (and Select All) 

You can copy and paste scanned images into other software.

1. Select the area of the scanned image to be copied by clicking 
and dragging the mouse over that area, or click Select All on 
the Edit menu to copy the entire image.

2. Click Copy on the Edit menu. The selected image will be 
copied to the Clipboard.

3. In your application, choose Paste (or a similar command). 
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View Menu 

This section describes the commands located on the View menu 
and the functions those commands perform. To access these 
commands, open EPSON Scan! II and click View.

All Dots[1:1]

Shows a scanned image with each pixel, or picture element, 
corresponding to one display dot in the active window. The 
higher the image resolution, the larger the display image.

Fit in Window

Modifies the size of the scanned image to match the current size 
of the active window. The smaller the active window size, the 
smaller the display image. This will center an image if the window 
is larger than the image.

Window Menu 

Lists all the images that have been scanned and opened.

To see all the names of the images that are currently open, click 
Window. Choosing a window name makes that window active and 
brings it to the front of the screen.
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When you install EPSON Scan! II & EPSON TWAIN, the EPSON 
Screen Calibration utility is automatically installed.

EPSON Screen Calibration calibrates your monitor to ensure the 
tone and contrast on your screen closely match the original image. 
Be sure to calibrate your screen before starting to use your scanner.

Calibrating Your Screen
 

You need to calibrate your screen when you first install the 
scanner software, and anytime you switch to a different monitor. 

For Windows 98 users 

1. Double click the  Scanners and Cameras icon  in the Control 
Panel. The Scanners and Cameras Properties dialog 
box appears. Click the Properties button.
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2. Click the Utility tab, then click the Screen Calibration Utility 
icon. The Screen Calibration dialog box appears. 

3. Click OK to finish calibrating your scanner and monitor.

 

The gray stripes will not perfectly blend together; however, try to make 
the different tones match as closely as possible.

The setting is automatically saved as the Screen profile in the 
Calibration list in EPSON TWAIN's Destination dialog box. 
Screen profile contains calibration information for the preview 
image as well as the scanned image.

r
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For other operating system users

1. Click the EPSON Screen Calibration icon in the EPSON scanner 
window (EPSON Scan! II folder) to view the Screen 
Calibration dialog box.

2. Look at the screen from a distance and move the slider right 
or left until the two tones closely match.

3. Click OK to finish calibrating your scanner and monitor.

The gray stripes will not perfectly blend together; however, try to make 
the different tones match as closely as possible.

The setting is automatically saved as the Screen profile in the 
Calibration list in EPSON TWAIN's Destination dialog box. 
Screen profile contains calibration information for the preview 
image as well as the scanned image.

Using ICM, ICM/sRGB (For Windows 95, 98 Users) 

If you use Windows 95 or 98 and your output devices (printer and 
monitor) support the ICM color management system, you can use 
the ICM calibration method. 
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For Windows 95 users

If your output devices do not support ICM, leave the check box clear.

Follow the steps below:

1. Run EPSON Scan! II and select Acquire or Acquire & Export to 
start EPSON TWAIN.

2. Click Configuration. Select ICM in the Configuration dialog box.

3. Make any other settings you desire.

4. Click Scan. The scanner scans an image using the ICM profile.
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For Windows 98 users

If your output devices do not support sRGB, leave the check box clear.

Follow the steps below:

1. Run EPSON Scan! II and select Acquire or Acquire & Export to 
start EPSON TWAIN.

2. Click Configuration. Select ICM/sRGB in the Configuration 
dialog box.

3. Make any other settings you desire.

4. Click Scan. The scanner scans an image using the sRGB profile.

Adding or removing profiles on the Color Management menu of your 
scanner’s properties dialog box will not affect the colors of your scanned 
images.
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Using ColorSync (For Macintosh Users)

If your output devices (printer and monitor) support the Apple 
ColorSync color management system, you can use the ColorSync 
calibration method. 

If your output devices do not support ColorSync, leave the check box 
clear.

Follow the basic steps below:

1. Run EPSON Scan! II and select Acquire or Acquire & Export to 
start EPSON TWAIN.

2. Click Configuration. Check ColorSync in the Configuration 
dialog box, then select Perceptual, Colorimetric, or Saturation 
from the drop-down list.

Select Perceptual for photographs, Colorimetric for spot color, and 
Saturation for color charts or graphs.

3. Make any other settings you desire.

4. Click Scan. The scanner scans an image using the ColorSync 
profile.

When the scanned image is printed or displayed with the output 
device calibrated for the scanner, the image reproduced is 
identical to the original.
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Problems and Solutions 

Most problems you encounter while operating your scanner and 
software have simple solutions. This section divides the problems 
into three categories:

Setup problems. . . . . . . . . . . . . . . . . . . . . . 7-3
Software operation problems . . . . . . . . . . 7-5
Scanning problems. . . . . . . . . . . . . . . . . . . 7-6

Read the appropriate section to find your problem; then follow 
the recommended steps.

If some settings appear dimmed in EPSON TWAIN, they cannot be 
selected because of the capability of your scanner or your choice of other 
settings.

If you cannot solve a problem after reading and following the 
information in this chapter, contact your dealer or a qualified 
customer support person for assistance.
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Setup problems

You cannot install EPSON TWAIN.

Cause What to do

System is configured 
incorrectly.

Check your computer and operating 
system meets the system 
requirements on page 1-2.

Make sure your computer has enough 
memory to run the application.

The scanner does not appear in the Port list of the EPSON 
TWAIN Setup dialog box when you connect the SCSI model 
to your PC runnning Windows other than Windows 98.

Cause What to do

The SCSI connection is not 
made properly.

Turn off the computer and scanner 
and check the connection between 
your hardware.

SCSI ID number is 
unsuitable.

Change the SCSI ID number to one 
that is not being used by any other 
SCSI device.

Connection sequence is 
incorrect.

Check the connection sequence and 
make sure the scanner’s terminator 
switch is set correctly. See the scanner 
manual for details.

No image appears after you click Test in the EPSON TWAIN 
Setup dialog box when using a PC.

Cause What to do
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No document on the 
document table.

Turn on the scanner and place a 
document on the document table.

The interface cable is 
unsuitable.

Make sure the interface cable meets 
the requirements of your interface 
board. See the manual that comes with 
the interface board.

The connection is not made 
properly.

Turn off the scanner and computer 
and check the connection between the 
scanner and computer.

Interface board is not 
installed properly.

Make sure the interface board is 
installed correctly.

Power on sequence is 
incorrect.

Turn off the scanner and computer. 
Turn on the scanner and then turn on 
the computer.

(For SCSI model users only) 
SCSI driver is not installed 
correctly.

Make sure the SCSI driver is properly 
installed.

SCSI ID number is 
unsuitable.

Change the scanner’s SCSI ID number 
to one that is not being used by any 
other SCSI device.

Connection sequence is 
incorrect.

Check the connection sequence and 
make sure the scanner’s terminator 
switch is set correctly. See the scanner 
manual for details.

Film Adapter is not switched 
off.

If the Film Adapter is installed, make 
sure it is switched off.
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Software operation problems

You cannot start up EPSON TWAIN 

Cause What to do

The scanner is switched off. Turn on the scanner and then turn on 
the computer.

The interface cable is 
unsuitable.

Make sure the interface cable meets 
the requirements of your interface 
board. See the manual that comes with 
the interface board.

The connection is not made 
properly.

Turn off the scanner and computer 
and check the connection between the 
scanner and the computer.

The interface board is not 
installed properly.

Make sure the interface board is 
installed correctly.

The software is not installed 
properly.

Make sure that EPSON TWAIN is 
selected properly in your application 
software. See “Starting EPSON 
TWAIN through your application 
software”on page 2-4.

You can’t select optional equipment (Auto Document Feeder 
or Film Adapter)

Cause What to do

The option is not installed 
properly.

Make sure the optional equipment is 
installed correctly. See your scanner 
manual.
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 Scanning problems

Image is dark, with little or no detail.

Cause What to do

The screen is not calibrated. Calibrate the screen as described in 
"Calibrating Your Screen" on page 6-3.

Destination setting is 
incorrect.

Select Screen as the Destination 
setting (pagex-xx). Selecting a printer 
may cause onscreen colors to be 
different from the colors of the 
original, however colors will be 
reproduced correctly when it is 
printed.

You cannot scan an image or you only get a few dots for the 
scanned image.

Cause What to do

There is no document on the 
document table.

Make sure you have placed a 
document on the document table of 
the scanner.

Threshold setting for OCR 
scanning needs changing.

When OCR is selected as the Image 
Type, try changing the Threshold 
setting in the Image Controls dialog 
box. See "Image Controls" on page 00.

Moiré (cross hatch) patterns appear in the scanned image 
during halftone scanning

Cause What to do

Image Type setting is 
unsuitable.

Select the Quality & de-screening 
setting in the Image Type dialog box.
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Transparent sheet was not 
used.

Place a transparent sheet between the 
document and document table to 
defocus the image.

Document is not positioned 
correctly

Move or angle the document slightly.

Sharpness setting is 
unsuitable.

Change Sharpness to a softer focus 
setting.

Image size setting is 
unsuitable.

Change the image size smaller 
slightly. 

Scanned image is too large.

Cause What to do

Destination setting Select Screen as the Destination 
setting.

Selecting a printer as the Destination 
setting, the print size will appear in 
the correct size even if the image is 
enlarged on the screen in some 
application .

Colors differs from the original or look strange.

Cause What to do

The screen is not calibrated. Calibrate the screen. See Chapter 6. 

Image Type and Destination 
settings are incorrect.

Make sure the Image Type and 
Destination settings are correct.
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Printed colors will not exactly match 
the colors on your monitor, since 
printers and monitors use different 
color systems: monitors use RGB (red, 
green, and blue), while printers 
typically use CMYK (cyan, magenta, 
yellow, and black).

Poor character recognition during OCR scanning

Cause What to do

Image Type setting is 
unsuitable.

Select OCR as the Image Type setting.

Threshold setting is 
unsuitable.

Try adjusting the Threshold  setting in 
the Image Controls dialog box.

There is background noise 
on the document

Select Text Enhancement Technology 
from the B/W Option in the Image 
Type dialog box.

Scanning does not start by pressing the Start button.

Cause What to do

The Scanner Monitor 
software is not installed 
properly.(For Windows 95, 
NT 4.0 or NT 3.51 )

Make sure the Scanner Monitor 
software is running and check the 
Scanner Monitor’s Launch 
Application path is set correctly.
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The Scanner Event is not 
selected properly. (For 
Windows 98 )

Click the Events tab in your scanner’s 
Properties dialog box and make sure 
the Disable device events check box is 
clear. And make sure the Start button 
is selected as the Scanner events, and 
at least one scanner event 
recognizable application in the Send 
to this application box is selected.
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Glossary 

additive primary colors
Primary colors which produce white when mixed in certain proportions. These 
are red, green, and blue—the colors of the scanner lamps and color monitor 
displays.

bi-level data
Image data that is composed of 1 bit/pixel. A pixel is represented by a single bit 
of digital data that can express only 1 (light) or 0 (dark). See bit/pixel.

bit
Short for binary digit. The smallest unit of data in computer processing. A bit can 
represent two values, on and off, or 1 and 0.

bit/pixel
The unit that indicates the number of bits allocated for a pixel. The larger the 
value, the more detail a pixel can represent.

browser
A program which allows a person to read hypertext. The browser gives some 
means of viewing the contents of nodes (or "pages") and of navigating from one 
node to another.

byte
A unit of information consisting of eight bits. A byte can represent a control code 
or character.

carriage
A component of the scanner that contains the optical sensor and light source for 
scanning. 

color correction
A method of adjusting the color image data for a particular type of device so that 
the reproduction results come close to the original colors.

color separation
A process to convert full-color images into a limited number of primary colors. 
The additive primary colors (red, green, and blue) are used by the scanner and 
the subtractive primary colors (cyan, magenta, and yellow) plus black are used 
for printing press separations.

ColorSync
Color management system for Macintosh that is designed to help you get 
WYSIWYG (what you see is what you get) color output. This software displays 
colors on your screen as they are on the scanned documents, or prints colors as 
you see them on your screen.
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default
A set of values used when no other selections have been made.

dithering
A process in which software or an output device simulates continuous tones with 
groups of dots.

document
The physical item, such as a sheet of paper or a book, that you place on the 
document table for the scanner to read.

dpi
Short for dots per inch. A unit of measurement for resolution. The higher the 
value, the higher the resolution.

dropout color
A color you set the scanner not to recognize.

ESC/I
Abbreviation for EPSON Standard Code for Image scanners, a system of 
commands that is used to control image scanners.

ESC/P
Abbreviation for EPSON Standard Code for Printers, a system of commands that 
is used to control printers.

exposure
A scanner function that lightens or darkens the scanned image data. 

halftoning 
Methods of using dot patterns to represent an image.

home position
The position at the back of the scanner where its carriage rests before a scanning 
operation.

ICM 
Image Color Matching. Windows color management system designed to help 
you get WYSIWYG (what you see is what you get) color output. This software 
displays colors on your screen as they exist on the scanned documents, or prints 
colors as you see them on your screen.

imagesetter
A device that uses computer files to produce high-resolution text and graphics 
output on film or paper. These are usually found in service bureaus and printing 
companies.

impact dot printer
A printer that transfers ink onto the paper by striking an ink ribbon with a number 
of small pins.
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ink jet printer
A printer that sprays ink onto paper through a number of small nozzles. 

interface
A piece of hardware, a method, or a standard used for connection between or 
among computer devices and peripherals.

laser printer
A printer that uses a laser and the electrophotographic method to print a full page 
at a time. The laser is used to "paint" a charged drum with light, to which toner 
is applied and then transferred onto paper.

line sequence
A type of color scanning that separates primary colors line by line. The carriage 
makes only one pass.

marquee
A moveable and adjustable frame that marks the area of an image that will be 
previewed or scanned.

monochrome
Black and white images, or images represented only by the intensity of 
luminosity.

OCR
Optical Character Recognition. The technology that allows computers to "read" 
the text from physical objects. It requires a graphical representation of text to 
interpret. This usually comes from a scanned image.

page sequence
The type of color scanning in which the entire image is scanned once for each 
separation color.

pixel
Short for picture element. Every image is composed of a number of pixels. Pixels 
are also counted in units of dots.

plain bi-level
Bi-level image data without the halftoning process. 

port
An interface channel through which data is transmitted between devices.

primary colors
Basic colors. See additive primary colors and subtractive primary colors.

resolution
Indication of how finely an image is resolved into pixels. Measured in dots per 
inch (dpi), pixels per inch (ppi), or samples per inch (spi).
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scan
An operation performed by the sensor and the carriage. The sensor “reads” the 
colors in an image, and sends the color information to the computer or an output 
device as digital data.

scanning area
The physical size of the area that will be scanned by the scanner. 

sRGB
A standard color space used as the default color space within the Windows 98 
color management system (ICM 2.0).

subtractive primary colors
Primary colors that produce black when mixed in certain proportions. These are 
cyan, magenta, and yellow. In printing, black is often added to give more 
definition because the mixing of color inks cannot produce pure black.

threshold
A value that is referenced to determine how data is represented; for example, 
data is represented as 1 (or on) if the value of the data is larger than the threshold 
value, and data is represented as 0 (or off) if the value of the data is smaller than 
the threshold value. Scanners use a number of thresholds to convert images into 
digital data.

tone correction
Methods of adjusting the tone curve that make sure the reproduced image is as 
close to the original as possible. The method varies depending on the output 
device.

tone curve
The graph that shows the contrast between the input (original image) and output 
(image data) in image processing.
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Index

Numerics

16-million colors 5-5
24-bit Color 4-8, 4-10
256 Colors 2-7, 4-8, 4-10
256-gray 5-5
4 x 4 Bayer 4-10
4 x 4 Net Screen 4-10
4 x 4 Spiral 4-10
8 x 4 Net Screen 4-10
8-bit Gray 4-9, 4-10

A

Acquire 2-4, 5-3
Acquire & Export 5-6
Advanced Menu 4-4
Advanced menu 4-3
Advanced menus 2-5
All Dots 5-9
Auto Area Segmentation 4-9, 4-11
Auto Exposure 4-7, 4-24, 4-29
Auto Locate 4-25, 4-26
Automatic Document Feeder 2-6, 3-6, 

4-7
Automatic Preview 4-29

B

B/W Option 4-11
B/W Options 4-11
Batch Scan 4-27
Bayer 4-10
Best & de-screening 4-11
Black & White 4-10
Black & White Photo 2-7, 4-9

C

calibrate 4-3, 4-4
Calibration Utility 6-3

Calibration utility 1-25
centimeters 4-16
Channels options 4-21
Close 5-7
Color Adjustment 4-7, 4-22
Color Halftone 4-10
Color management 6-4
Color Photo 2-7, 4-8
Colorimetric 6-7
ColorSync 1-4, 4-30, 6-7
Compression 5-5
Configuration 4-28
Copy (and Select All) 5-8
Copy&Fax 2-7
Copy/Fax 4-9

D

Destination 2-7, 4-3, 4-12
DIB 2-10, 5-5
disk space 4-3, 4-4
Dither 4-10
Document Feeder 3-6
Document Source 2-6, 4-3, 4-7
Draft & fast 4-11
Dropout 4-6, 4-10

E

Easy Menu 4-3
Easy menu 2-5
Edit Menu 5-8
EPS 2-10, 5-5
EPSON Printers 4-12
EPSON printers 2-7
EPSON Scan! II 1, 2-3, 2-8, 5-1
EPSON Scanner Monitor 1, 2-11, 3-2, 

3-7
EPSON Screen Calibration utility 2, 

1-16, 6-3
EPSON starting 2-3
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EPSON TWAIN 1, 1-8, 1-10, 1-14, 
1-16, 1-18, 1-19, 1-20, 2-3, 2-11, 3-6, 
4-1, 4-2, 4-3

Exit 2-7, 5-7
Export 2-8, 2-9, 5-4
Exposure 4-6, 4-18

F

Fast Preview 4-29
Fax 2-7, 4-12
File format 2-10
File Menu 5-2
File Name 2-8
File name 2-10
File Name field 2-8, 2-10
Film Adapter 2-6
Fit in Window 5-9
Flatbed 2-6, 4-7

G

Gamma 4-6, 4-18
Gray Balance Intensity 4-7, 4-23

H

Halftone 4-6, 4-10
Hard Tone 4-10
Highlight 4-6, 4-18
HTML Browser 1-21

I

ICM 4-29, 6-5
Image Controls 4-6, 4-17
Image exporting 2-9
Image saving 2-8
Image scanning 2-5, 4-3, 4-4
Image Size 4-15
Image Type 2-7, 4-3, 4-6, 4-8, 4-10
inches 4-16
InkJet Printer 4-12
Inkjet Printer 2-7
Installation software 1-4

Installation software before 1-2
Interface 1-2, 1-3

J

JPEG 2-10, 5-5

L

Laser Printer 2-7, 4-12
Line Art 2-7, 4-9
Lock button 4-16

M

Macintosh 1-25, 2-3, 2-10, 2-12, 3-10, 
4-2

marquee 4-6
memory 4-3, 4-4

N

Net Screen 4-10

O

OCR 2-7, 4-9, 4-11, 4-12
Online Help 2-12
Open 5-7
Original file format 2-8, 2-9
Output options 4-21

P

PageManager for EPSON 1, 2-11, 3-2
PCX 2-10, 5-5
Perceptual 6-7
PICT 2-10, 5-5
Pixel Depth 4-6, 4-10
pixels 4-16
Preview 4-5
preview button 4-5
Preview window 4-5
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Q

Quality & de-screening 4-11
QuickDraw 5-5
QuickTime 1-4

R

Reset Button 4-24
Resolution 4-13

S

Saturation 4-7, 4-23, 6-7
Save As 5-3
Save button 4-22
Save Preview Image and Settings 4-28
Scale bar 4-16
Scale indicator 4-16
Scan Button 3-2, 3-5
Scanner 1-2
Scanner event 3-12
Scanner Monitor EPSON 1, 2-11, 3-2, 

3-7
Scanners and Cameras 1-14, 3-12
Screen 2-7, 4-12
Screen Calibration 6-3
Screen calibration 1-27
Screen Vivid 2-7, 4-12
Select All 5-8
Settings 4-27
Setup EPSON TWAIN 1-8, 1-19
setup EPSON TWAIN 1-13
Shadow 4-6, 4-18
Sharpness 4-14
Soft Tone 4-10
Software requirements 1-2, 1-3
Source 4-15, 5-2
Spiral 4-10
sRGB 4-29, 6-6
Start Button 1, 3-1
Start button 2-2, 2-11
Storage size indicator 4-16
System requirements 1-2

T

Target 4-15
Test button 1-9
Text Enhancement Technology 4-9, 

4-11
Threshold 4-6, 4-19
TIFF 5.0 2-10, 5-5
TIFF 6.0 2-10
TIFF 6.0 (JPEG) 5-5
Tone Correction 4-6, 4-19
Tone correction list 4-22
Tone Curve editor 4-21
TPU for Neg. Film 2-6, 4-8
TPU for Pos. Film 2-6, 4-8
Troubleshooting 7-1
TWAIN Select Source 2-5, 5-2
Twain Select Source 2-4

U

Units menu 4-16

V

View Menu 5-9

W

Width and Height menu 4-15
Window Menu 5-9
Windows 1-3, 2-10, 2-12
Windows 95 1-4, 1-19, 2-3, 3-7, 6-4
Windows 98 1-10, 1-19, 2-3, 3-2, 3-7, 

3-12, 6-2
Windows NT 3-7
Windows NT 3.5x 1-21, 2-3, 3-9
Windows NT 4.0 1-4, 2-3, 3-7

Z

zoom preview button 4-5
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